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VOCATIONAL DIPLOMA EXAMINATION –  

DECEMBER 2020 

DTP Operator 

WINDOWS AND MS-WORD 

Time : 3 hours Maximum  marks : 75 

PART A — (5  5 = 25 marks) 

Answer any FIVE questions. 

1. Explain the characteristic of computer. 

 

2. How to coping and moving files and folder? 

 

3. Write short notes on Auto Text. 

 

4. Explain how will you add bullets in your 

document. 
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5. Briefly explain various types of memory. 

 

6. What is the procedure of inserting symbols in  

MS-Word? 

 symbols insert 

7. How can you customize the desktop? 

 

8. Explain the mouse, sounds and fonts. 

 

PART B — (5  10 = 50 marks) 

Answer any FIVE questions. 

Q.No. 9 and 10 compulsory. 

 Choose the correct answer :  (10  1 = 10) 

9. (a) The key F12 opens a    

  (i) save as dialog box 

  (ii) open dialog box 

  (iii) close dialog box 
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  F12 ––––––––––––  

  (i)  

  (ii)  

  (iii)  

 (b) How many ways you can save a document?    

  (i) 3  (ii) 4 

  (iii) 5 

  

 

  (i) 3  (ii) 4 

  (iii) 5 

 (c) Borders can be applied to     

  (i) cells  (ii) paragraph 

  (iii) both 

   

 (i)  (ii) 

  (iii)  

 (d) Portrait and Landscape are    

  (i) page orientation 

  (ii) paper size 

  (iii) page layout  
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  (i)  

  (ii)  

  (iii)  

 (e) What is the default left margin in word?    

  (i) 1    (ii) 52.1   

  (iii) 5.1   

 

  (i) 1    (ii) 52.1   

  (iii) 5.1   

 (f) Computer system is made up of    

  (i) input and output device 

  (ii) memory and CPU 

  (iii) both 

  –––––––––––––   

  (i)  

  (ii) CPU 

  (iii)  

 (g) Pen drive is a –––––––––––––.     

  (i) primary memory 

  (ii) secondary memory 
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  (iii) both 

  –––––––––––––  

  (i)  

  (ii)  

  (iii)  

 (h) E-mail is also known as –––––––––––––.    

  (i) Effective mail 

  (ii) Electronic mail 

  (iii) Electric mail 

 –––––––––––––

  (i)  

  (ii)  

  (iii)  

 (i) MS-DOS is an –––––––––––––.    

  (i) Application software 

  (ii) Program 

  (iii) Operating system 

  MS-DOS –––––––––––––

  (i)  

  (ii)  

  (iii)  
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 (j) The calculator is a useful application that 

comes with –––––––––––––.    

  (i) windows (ii) word 

  (iii) excel   

  –––––––––––––

 

 (i) (ii) 

  (iii)  

10. State whether the following are true or false :  

      (10  1 = 10) 

 (a) The personal computer are sometimes called 

home computers. 

  

 

 (b) Fifth generation computing device is based 

on artificial intelligence. 

  

 

 (c) Touch sensitive screen is an input device. 

   

 (d) Table can be created in MS-Word. 
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 (e) You can access the control panel from my 

computer. 

  my computer – 

 

 (f) Check boxes are used to enable and disable 

options. 

  

 

 (g) The date and time properties dialog box only 

shows the calendar of the current month. 

  Date time properties

 

 (h) The clipboard is a temporary storage for data 

being copied or moved. 

  

 

 (i) You can draw using wordpad. 
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 (j) In MS-word, print preview option is in File 

menu. 

  option  

11. Describe the various input and output devices. 

 

12. Explain evolution of the windows operating 

systems. 

 

13. Explain in detail about mail-merge with an 

example. 

 

14. What is WWW? Explain in detail. 

 WWW 

15. How to create a new document? Explain. 

 

16. Explain the various text formats. 
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VOCATIONAL DIPLOMA EXAMINATION - DECEMBER- 2020 

DTP OPERATOR 

WINDOWS AND MS-WORD 

Time: 3 Hours               Maximum Marks: 70 

PART –A                (3 x 3 = 9 Marks) 

Answer any Three questions out of Five questions in 100 words. 

All questions carry equal Marks. 

1. What are the uses of control panel in windows? 

tpz;Nlh]py; fz;l;Nuhy; Ngdypd; gad;ghLfisg; gw;wp vOJf. 

2. Write short notes on: Internet. 

Internet gw;wp rpW Fwpg;G tiuf. 

3. Write short notes on E-mail 

E-mail. - rpW Fwpg;G tiuf 

4. Explain the characteristics of computer. 

fzpdpapd; gz;Gfis tpsf;Fq;fs;. 

5. Write the difference between Hardware and Software. 

td;nghUs; kw;Wk; nkd;nghUs; ,ilNa cs;s tpj;jpahrj;ij  vOJf. 

 

PART –B    (3 x 7 = 21 Marks) 

Answer any Three questions out of Five questions in 200 words. 

All questions carry equal Marks.  

6. What are the uses of Notepad? 

Notepad-d; gad;ghLfisg; gw;wp vOJf. 

7. How do you install and uninstall a new hardware and software program in you 

Computers? 

fk;g;a+l;lupy; xU Hardware kw;Wk; Software vt;thW epWTjy; kw;Wk; ePf;Fjy; 

gw;wp vOJf. 

8. Explain the classification of Computer. 

fzpdp tifg;gLj;jiy vOjTk;. 

9. How to create a document? Explain. 

xU  Mtzj;ij vt;thW cUthf;FtJ? tpsf;F 

10. Explain the advantage of Computer. 

fzpdp  ed;ikfis tpsf;Ff. 
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PART – C                  (4 x 10 = 40 Marks) 

Answer any Four questions out of Seven questions in 500 words. 

All questions carry equal Marks. 

 

11. Discuss about the features of windows. 

tpz;Nlh]pd; mk;rq;fisg; gw;wp tptup. 

12. Explain about the format and Edit menu in word pad. 

Word pad-d; Format kw;Wk; Edit nkDit gw;wp tptup. 

13. Explain the various input devices. 

gy;NtW cs;sPl;L fUtpfis tptup. 

14. How do you drawing different objects in paint brush? Explain. 

Paint bursh-y; vt;thW gyjug;gl;l Mg;[f;l;il tiutha;? tptup. 

15. Explain the various tool in the paint application. 

ngapz;l; gad;ghL gy;NtW fUtpfs; tpsf;Ff. 

16. What is WWW? Explain in detail. 

WWW vd;why; vd;d? tpupthf tpsf;Fq;fs;. 

17. Discuss in detail about the find and replace command in MS-Word. 

MS-Word ,y; fz;lwpe;J> fl;lisiag; gw;wp tpupthf tpthjpf;fTk;. 



1 VDIP-C-256  

 

 

 

VOCATIONAL DIPLOMA EXAMINATION —  

DECEMBER 2020 

PAGEMAKER 

Time : 3 hours Maximum marks : 75 

PART A — (5  5 = 25 marks) 

Answer any FIVE questions. 

1. Explain the usage of kerning in PageMaker. 

 PageMaker- kerning  

2. Explain the advantages of PageMaker. 

 PageMaker-  

3. Explain indents in PageMaker with examples. 

 

4. Explain table editor with suitable example. 

 

5. Explain the usage of PageMaker. 
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 PageMaker-  

6. What is Type style? How will you use it? 

 

7. Explain the working with control and palette. 

 

8. Explain the concept of mirroring and cloning 

grids. 

 

PART B — (5  10 = 50 marks) 

Answer any FIVE questions, Q.No. 9 and 10 

compulsory. 

9. Choose the correct answer :  (10  1 = 10) 

 (a) The layout of the page depends on  

––––––––––––. 

  (i) On page size  (ii) On Text 

  (iii) On Paragraph (iv) All of the above 

  ––––––––––––  

  (i)   

  (ii)  
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  (iii)   

  (iv)  

 (b) Which of the options is not available in the 

Type Style in PageMaker? 

  (i) Bold   (ii) Italic 

  (iii) Strikethrough (iv) Indent 

  PageMaker-

 

  (i)   (ii)  

  (iii)  (iv)  

 (c) What is the shortcut key of Find? 

  (i) Ctrl + F  (ii) Ctrl + H 

  (iii) Ctrl + Y  (iv) Ctrl + Z 

   

  (i) Ctrl + F  (ii) Ctrl + H 

  (iii) Ctrl + Y  (iv) Ctrl + Z 

 (d) Shortcut Key of UNDO is ––––––––––––. 

  (i) Ctrl + X  (ii) Ctrl + H 

  (iii) Ctrl + Y  (iv) Ctrl + Z 
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  UNDO- ––––––––––––  

  (i) Ctrl + X  (ii) Ctrl + H 

  (iii) Ctrl + Y  (iv) Ctrl + Z 

 (e) What is the extension of file created in 

PageMaker? 

  (i) PSD   (ii) PMD 

  (iii) Tiff   (iv) Txt 

  PageMaker-

extension  

  (i) PSD   (ii) PMD 

  (iii) Tiff   (iv) Txt 

 (f) Which company had developed PageMaker? 

  (i) Microsoft 

  (ii) Adobe Corporation 

  (iii) Aldus Corporation 

  (iv) Intel 

   

  (i)  

  (ii)  

  (iii)  

  (iv)  
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 (g) How many alignments are there in 

PageMaker? 

  (i) 3   (ii) 4 

  (iii) 5   (iv) 6 

  PageMaker-

 

  (i) 3   (ii) 4 

  (iii) 5   (iv) 6 

 (h) What is the unit to measure the quality of 

the picture? 

  (i) DPI   (ii) LPI 

  (iii) PPI   (iv) CCD 

   

  (i) DPI   (ii) LPI 

  (iii) PPI   (iv) CCD 

 (i) Which of these software can be a master 

page? 

  (i) PageMaker  (ii) Painting 

  (iii) Photoshop  (iv) All of these 

   

  (i) PageMaker 

  (ii)  

  (iii)  

  (iv)  

 (j) Which menu contain the show master page 

option in PageMaker? 
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  (i) Layout  (ii) Window 

  (iii) Element  (iv) Utilities 

  PageMaker-

 

  (i)   (ii)  

  (iii)  (iv)  

10. State whether the followings are True or False : 

      (10  1 = 10) 

 (a) Vector Graphics is used in PageMaker. 

  Vector PageMaker-

 

 (b) Ctrl + K is the shortcut key for Show 

Hyperlinks in PageMaker. 

  Ctrl + K PageMaker-

 

 (c) Select all option is available in Select Menu 

in PageMaker. 

  PageMaker-

 

 (d) Short cut key for ‘Save As’ in PageMaker is 

Shift + Ctrl + S. 

  PageMaker- ‘ ’ 

Shift + Ctrl + S  
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 (e) It is possible to insert a picture in 

PageMaker. 

  PageMaker-  

 (f) Copy Master Guides option is available in 

Edit Menu in PageMaker. 

  PageMaker-

 

 (g) Preferences option is available in View Menu 

in PageMaker. 

  PageMaker-  View-

 

 (h) PageMaker provide two types of case 

attributes. 

  PageMaker 

 

 (i) We can change Polygon Settings from 

Element Menu in PageMaker. 

  PageMaker-

Polygon  

 (j) In PageMaker, Ctrl + J is the shortcut key 

for justify. 

  PageMaker, Ctrl + J-
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11. List out the various utilities available in 

PageMaker and explain each of them. 

 PageMaker-

 

12. Discuss about working with Graphics in 

PageMaker. 

 PageMaker-

 

13. Discuss about the setting of a documents size and 

margin. 

 

14. Design one invitation card in PageMaker. Explain. 

 PageMaker-

 

15. Explain the setting up of publication in 

PageMaker. 

 PageMaker-

 

16. Explain in detail the Layout menu in PageMaker. 

 PageMaker-
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VOCATIONAL DIPLOMA EXAMINATION - DECEMBER 2020 

DTP OPERATOR 

PAGE MAKER 

 

Time: 3 Hours       Maximum Marks: 70 

Section A (3 x 3 = 9 Marks) 

Answer any THREE questions out of Five questions in 100 words. 
All questions carry equal marks. 
 
1. Explain about the page editing properties? 

gf;fj;ij khw;wk; nra;Ak; Kiw gw;wp vOJf. 
 

2. Write on character specification and paragraph specification. 
Nfuf;lu; ];ngrpgpNf\d; kw;Wk; Nguhfpuh‡g; ];ngrpgpNf\d; gw;wp vOJf. 
 

3. What are the primary colours? 
Kjd;ik epwq;fs; ahit? 
 

4. Explain the uses of copy, paste and paste multiple commands. 
Copy, paste, multiple commands-d; gad;fs; gw;wp tptup. 
 

5. Write the uses of any five page maker tools. 
Ng[;Nkf;fu; ^y;];-d; VjhtJ 5 gad;fis vOJ. 
 

Section B (3 x 7 = 21 Marks) 

Answer any THREE questions out of Five questions in 200 words. 
All questions carry equal marks. 

6. How to import image in page maker? Explain. 
Ng[;Nkf;fupy; vt;thW image-I import nra;ayhk;? 
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7. Discuss the styles  in pagemaker. 
Ng[;Nkf;fupy; cs;s styles gw;wp vOJf. 
 

8. Explain real time applications of photoshop. 
Photoshop-y; cs;s upay; ilk; mg;spNfrd; gw;wp tptup. 
 

9. Write short notes on DTP applications. 
bbgp mg;spNf\d;]; gw;wp vOJf. 
 

10. List out the various commands in document views. 
lhf;Fnkz;l; tpa+]; cs;s gy;NtW fl;lisfis gl;baypLf. 
 

Section C (4 x 10 = 40 Marks) 

Answer any FOUR questions out of Seven questions in 500 words. 
All questions carry equal marks. 

11. What are the advantages of edit story? 
vbl; ];Nlhup-d; gad;ghLfis gw;wp vOJf. 
 

12. Describe the various tools on the toolbar. 
^y;ghupy; cs;s gy;NtW ^y;fisg; gw;wp tptup. 
 

13. Describe the various options of the paragraph dialog box. 
Paragraph dialog box-y; cs;s gy;NtW Mg;\d;i] gw;wp tptup. 
 

14. Describe any five templates in pagemaker.  
Ng[;Nkf;fupy; cs;s VNjDk; Ie;J nlk;g;Nsl;il gw;w tptup. 
 

15. Explain the process of creating table of contents. 
Nlgps; Mg; fd;ld;l; cUthf;Fk; Kiwia gw;wp tptup. 
 

16. Discuss about the layers in Pagemaker.  
Ng[;Nkf;fupy; Nyau;fis gw;wp ciuahL. 
 

17. What are Indents and Tabs? Explain. 
,d;nld;l;]; (Indents) kw;Wk; Nlg;]; vd;why; vd;d? 
 

 

 

 



  

 

 

VOCATIONAL DIPLOMA EXAMINATION –  

DECEMBER - 2020 

DTP Operator 

COREL DRAW AND PHOTOSHOP 

Time: 3 Hours Maximum Marks: 75 

PART A (5 × 5 = 25 Marks) 

Answer any FIVE questions. 

1. What is meant by layers in Photoshop? Explain. 

 Photoshop

2. Explain image selection in Photoshop. 

 Photoshop Image selection 

 

3. Explain Crop tool and Clone tool in Photoshop. 

 Photoshop Crop tool  Clone tool 

 

4. What are the main feature of Photoshop? 

 Photoshop  

5. Explain the text effect in Corel draw. 

 Corel draw text effect  
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6. How to add 3D effects in Corel draw? 

 3D 

 

7. Explain in detail about transforming object. 

 Transforming object  

8. What are different copy options in Corel draw? 

Explain. 

 copy option 

PART B (5 × 10 = 50 Marks) 

Answer any FIVE out of Eight questions. 

Question 9 and 10 compulsory. 

9. Choose the correct answer :  (10  1 = 10) 

 (a) In Corel draw the keyboard shortcut to save 

your drawing is 

  (i) Ctrl + S 

  (ii) Ctrl + C 

  (iii) Alt + S 

  drawing 

shortcut  

  (i) Ctrl + S 

  (ii) Ctrl + C 

  (iii) Alt + S  
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 (b) What is the shortcut key to toggle snapping 

to object? 

  (i) Alt + Z 

  (ii) Ctrl + G 

  (iii) Ctrl + L 

  shortcut 

key  

  (i) Alt + Z 

  (ii) Ctrl + G 

  (iii) Ctrl + L 

 (c) ––––––––– tool is used for cropping 

  (i) Pick tool 

  (ii) Shape tool 

  (iii) Zoom tool 

  –––––––––  

  (i)  

  (ii)  

  (iii)  

 (d) The ruler bar is used for ––––––––– 

  (i) Setting of margin 

  (ii) Dividing your work 

  (iii) Both 
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  Ruler bar –––––––––  

  (i)  

  (ii)  

  (iii)  

 (e) Corel draw is a ––––––––– based drawing 

application package 

  (i) Photo paint 

  (ii) Bitmap 

  (iii) Vector 

  

 

  (i)  

  (ii)  

  (iii)  

 (f) To get auto contrast option in Photoshop, 

select  

  (i) Filter menu 

  (ii) File menu 

  (iii) Image  adjustment 

  Photoshop  Auto contrast

 

  (i)  

  (ii)  

  (iii)   
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 (g) How many color modes are there in 

Photoshop? 

  (i) 5 

  (ii) 4 

  (iii) 6 

  Photoshop  

  (i) 5 

  (ii) 4 

  (iii) 6 

 (h) How many types of gradient are there in 

Photoshop? 

  (i) 5 

  (ii) 4 

  (iii) 6 

  Photoshop

 

  (i) 5 

  (ii) 4 

  (iii) 6 

 (i) How many type of marquee tool are there in 

Photoshop? 

  (i) 4 

  (ii) 3 

  (iii) 2 



 VDIP-C-257 6 

  Photoshop

  (i) 4 

  (ii) 3 

  (iii) 2 

 (j) To get feather option in Photoshop 

  (i) Image menu 

  (ii) Select menu 

  (iii) Edit menu 

  Photoshop  Feather option 

––––––––– 

  (i)  

  (ii)  

  (iii)  

10. State true or false :   (10  1 = 10) 

 (a) Overlay is a layer blending mode in 

Photoshop. 

  

 

 (b) GIF does not support background 

transparency. 

  GIF 
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 (c) Roster graphic consists of pixels. 

   

 (d) Liquify is a filter. 

  Liquify  

 (e) Extension of Photoshop is PSD. 

  Photoshop  PSD. 

 (f) Graphics effects can be introduced throw 

Corel draw. 

  

 

 (g) Pick tool is not in Corel draw. 

   

 (h) Import bitmap is possible in Corel draw. 

   

 (i) Blending object is possible in Corel draw. 

  Blending object  

 (j) F3 is shortcut key for zoom out in Corel 

draw. 

  F3 
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11. Explain in detail about any two menus in 

Photoshop. 

 Photoshop

 

12. Explain different filter option in Photoshop. 

 Photoshop filter 

option 

13. Discuss about working with graphics in 

Photoshop. 

 Photoshop

 

14. Discuss about the tools available in the standard 

tool bar in Corel draw. 

 Corel draw standard tool bar

 

15. Explain about error rectification. 

 Error rectification  

16. Discuss about blend option with example. 

 

––––––––––––– 
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VOCATIONAL DIPLOMA EXAMINATION - DECEMBER- 2020 

DTP OPERATOR 

CORELDRAW AND PHOTOSHOP 

Time: 3 Hour              Maximum Marks: 70 

PART –A     (3 x 3 = 9 Marks) 
Answer any Three questions out of Five questions in 100 words. 
All questions carry equal Marks. 

1. Give the importance of Fountain fill tool with example. 
Fountain fill tool-d; Kf;fpaj;Jtj;ij vLj;Jf;fhl;Lld; tptup. 

2. Mention the Corel Draw techniques used in DTP. 
DTPapy; Corel Draw gad;gLj;Jk; Kiwfs; gw;wp vOJf. 

3. Write short notes in Contour Tool. 
fhz;̂ u; ^y; rpW Fwpg;G tiuf. 

4. How to import and export images ? Explain. 
glq;fis vg;gb import kw;Wk; export nra;J? tptupf;f. 

5. Explain how would you move toolbars in Corel Draw? 
Nfhuy; l;uhtpy; ^y;ghu; option-I vt;thW efu;j;JtJ. 

 
PART –B    (3 x 7 = 21 Marks) 

Answer any Three questions out of Five questions in 200 words. 
All questions carry equal Marks. 
  

6. Explain how to draw multiple shopes in layer. 
gpy; tifahd jpUg;Gfhd Nyau; tptup.  

7. Write the procedure of transparent layer. 
buhd;];gpuz;l; Nyaupd; top Kiwfisg; gw;wp vOJf. 

8. Give the importance of Fountain fill  tool with example. 
Fountain fill tool-d; Kf;fpaj;Jtj;ij vLj;Jf;fhl;Ld; tptup. 

9. What are the types of transforming selection? Explain it.  
gy;NtW tifahd gpujpg;G Nju;e;njLj;jy; gw;wp tptup. 
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10. Write short notes about tools in Photoshop. 
Photoshop-y; cs;s ^y;fisg; gw;wp vOJf. 

PART –C    (4 x 10 = 40 Marks) 
Answer any Four questions out of Seven questions in 500 words. 
All questions carry equal Marks. 

 
11. What are the types of transforming selection? Explain.  

gy;NtW tifahd gpujpg;G Nju;e;njLj;jy; gw;wp tptup. 

12. Explain the types of blend modes in Photoshop. 
‡Nghl;Nlh \hg;gpy; cs;s gpnsd;l; Nkhl;]; tiffis tpupthf tptup. 

13. Explain the text effect in Corel Draw. 
Corel Draw- tpy; text effect gw;wp tptupf;f. 

14. What is selection menu? Explain in detail. 
nryf;\d; nkD vd;why; vd;d? tpupthf tptup. 

15. Describe the options of color styles docker in Corel draw. 
Nfhuy; l;uhtpy; fyu; ];ily;]; Nlhf;fupy; cs;s Mg;\d;i] tptup. 

16. Describe the various options of Polygon tool in Corel draw. 
Nfhuy;l;uhtpy; ghypfhd; ^ypd; Mg;\d;i] tptup. 

17. Explain the process of converting the parent mode to lab in photoshop. 
tz;zj; jd;ikia Nyg; Nkhbw;F khw;Wk; topKiwfis tpsf;Ff? 
 


